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1. Preface


1.1. Audience

This book is written for computer literate folk who want to use
Mercurial to manage their data, but are uncomfortable using the command
line client to do so. Since TortoiseHg is a Windows shell extension it’s
assumed that the user is familiar with the Windows explorer and knows
how to use it.

You can find the most up to date version of this documentation at our
web [https://tortoisehg.bitbucket.io] site.



1.2. Reading guide

This Preface explains a little about the TortoiseHg project, the
community of people who work on it, and the licensing conditions for
using it and distributing it.

The Introduction explains what TortoiseHg is, what it does, where it
comes from and the basics for installing it on your PC.

A Quick Start Guide to TortoiseHg is a quick tutorial on how to start with TortoiseHg.

TortoiseHg in daily use is the main chapter, it describes the frequently used
components of TortoiseHg.

Settings describes how to configure TortoiseHg.

Use with other VCS systems describes how to use TortoiseHg as a client for
non-Mercurial servers.

Frequently Asked Questions has a list of common questions and their answers.

Debugging describes how to debug any problems that you find.



1.3. TortoiseHg is free!

TortoiseHg is released under
GPLv2 [https://www.gnu.org/licenses/gpl-2.0.html].  You are free to
install it on as many computers as you like, and to redistribute it
according to the GPLv2 license.



1.4. Community

Mailing List:

`Developers <thg-dev@googlegroups.com>`_ - Patches, bug reports, development discussions.





And our wiki [https://bitbucket.org/tortoisehg/thg/wiki/Home] on Bitbucket.



1.5. Acknowledgements

Thanks to the many people who contribute to the TortoiseHg project.  It
takes a community of developers, translators, and users to build a
truly useful tool (especially users who care enough to report bugs and
file feature requests).

The TortoiseHg installer for Windows includes the TortoiseOverlays handler,
as provided by the TortoiseSVN [https://tortoisesvn.net] project.

The history viewer of TortoiseHg is based on
hgview [https://www.logilab.org/project/hgview], a tool developed by
David Douard and others, with the financial
support of Logilab [https://www.logilab.fr].



1.6. Conventions used in this manual

The following typographical conventions are used in this manual:


	Ctrl-A

	Indicates a key, or combination of keys, to press.



	Commit

	Indicates a label, button or anything that appears in user interfaces.



	TortoiseHg… ‣ About

	Indicates a menu choice, or a combination of menu choice, tab
selection and GUI label.  For example
TortoiseHg…  ‣ Global settings ‣ Commit ‣ User name
means do something in User name label under
Commit tab selectable from the menu choice
TortoiseHg… ‣ Global settings.



	.hg/hgrc

	Indicates a filename or directory name.



	thg log

	Indicates a command to enter into command window.



	myproxy:8000

	Indicates a text to enter into a text input field in the GUI.






Note

This is a note.
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2. Introduction


2.1. What is TortoiseHg?

TortoiseHg is a set of graphical tools and a shell extension for the
Mercurial [https://www.mercurial-scm.org/wiki/] distributed revision control
system.


Note

hg is the symbol for the chemical element Mercury [https://en.wikipedia.org/wiki/Mercury_%28element%29]
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3. What’s New


3.1. TortoiseHg 2.0


3.1.1. Philosophy

The following philosophical changes were made between TortoiseHg 1.0 and
TortoiseHg 2.0.


3.1.1.1. Workbench

We wanted a single ‘TortoiseHg’ application which can access nearly all
TortoiseHg (and Mercurial) functionality and that could be launched by a
desktop or start menu shortcut.  So we developed the Workbench
application.

The Workbench can support multiple repositories open at a time via “Repo
Tabs” across the top of the main window.

Each repository tab supports multiple “Task Tabs” beneath its graph
splitter.  These task tabs are switchable via icons on the side of
the Workbench or via application menus.  Available task tabs include a
changeset browser, a commit tool, a history search widget, and a sync widget.

Also available are two dockable widgets - a Repository Registry which
lists all known repositories on your local machine and an Output Log
Window which displays running command lines and their output and can
also function as a minimal shell.



3.1.1.2. Showing Mercurial command lines

In an effort to educate users on Mercurial’s command interface, nearly
all commands are executed in the log window, displaying the full command
line and Mercurial’s output (progress indication is provided by progress
bars inside the Workbench status bar).  The few tools that do not use a
command log window will generally display the command line they execute.



3.1.1.3. Resolve tool, deliberate merges

TortoiseHg 2.0 introduces a resolve dialog for resolving conflicted
file merges.  It shows the users all the files that require resolution
and those files that have been resolved, allowing merges to be verified.

As supported by Mercurial’s resolve command, individual file merges may
be restarted as many times as necessary to get the merge correctly
completed.

By default, TortoiseHg will use the resolve dialog to resolve all
conflicts, including trivial conflicts.  It instructs Mercurial to never
merge files automatically, deferring their resolution until the resolve
dialog can be launched.  This is true for merges, update commands that
require content merges, rebases, and backouts.



3.1.1.4. Shelve Improved

TortoiseHg 2.0 includes a new shelve tool which is capable of moving
changes between your working directory, a shelf file, or an unapplied MQ
patch.



3.1.1.5. Revision Sets

We have replaced the filter bar of the Repository Explorer with a
revision set bar in the Workbench.  Revision sets were introduced in
Mercurial 1.6 and have been integrated with an increasing number of
commands in each subsequent release.  They are a powerful query language
for finding and specifying revisions in your repository.

The Workbench also includes a revision set editor which both teaches the
user the available keywords and their arguments, and offers brace
matching, auto-completions, and other editing amenities.

In TortoiseHg 2.0, incoming and outgoing changesets are visualized as
revision sets.  In previous versions they were represented by graph
annotations.




3.1.2. Technology


3.1.2.1. Qt and PyQt

TortoiseHg 2.0 has been a near rewrite of all of the tools and dialogs
taking advantage of Digia’s excellent Qt [https://www.qt.io/]
UI framework and Riverbank Computing’s fine
PyQt [https://www.riverbankcomputing.com/software/pyqt/intro] Python
bindings.



3.1.2.2. QScintilla2

TortoiseHg uses the QScintilla2 [http://pyqt.sourceforge.net/Docs/QScintilla2/]
editing component extensively to:


	display file contents and diffs with syntax highlighting


	display annotations with syntax highlighting


	edit commit messages with auto-completion of filenames and source symbols


	edit revision set strings with brace matching and auto-completion




One can configure the QScintilla2 tab stop parameter using the settings
tool, while white space visibility and wrap are controlled by context
menus.



3.1.2.3. Polling of repository state and config

The Workbench and other applications like the commit tool will poll
repositories on your local machine to detect changes made to either the
repository or their configuration files, and automatically update
running applications as necessary.  Nearly all configuration changes are
effective immediately, with the notable exception of enabling or
disabling Mercurial extensions.  Changes to extension configuration
generally require application restarts before they take effect.



3.1.2.4. Immediate bug report dialogs

Prior to TortoiseHg 2.0, bug reports were written to stderr as they
occured and stderr was captured and scanned at exit to report those
errors to the user.  While we gained many valuable bug reports via this
mechanism, there was rarely any context on what operations caused these
bugs.

In TortoiseHg 2.0, we have created a generic exception handler that
catches all Python exceptions that are otherwise unhandled by
application code.  This allows us to display exception tracebacks almost
immediately after they occur (after a short timeout to collect
consecutive exceptions together).  The hope is that future bug reports
will contain better reproduction instructions, or at least context for
the tracebacks.



3.1.2.5. Demand loaded graph

To keep refreshes as efficient as possible, the graphing algorithm will
only load a couple hundred revisions initially during a refresh, and
then load further revisions only when those revisions are required to be
displayed.  You will notice scrolling through the graph is jerky, these
are bulk loads of revisions into the graph.  To avoid this jerkiness you
can force TortoiseHg to load all revisions in the graph via the
Load all revisions option from the View menu.
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4. A Quick Start Guide to TortoiseHg

Welcome to TortoiseHg and the Mercurial!  TortoiseHg is a set of graphical
applications and Windows Explorer shell extension that serve as a friendly
front-end to the Mercurial distributed version control system (DVCS).

All TortoiseHg functionality is reachable from 3 places:


	The Workbench application

You can start the Workbench from the Start Menu, or by right clicking on the
Desktop and selecting Hg Workbench.


[image: Desktop Context Menu]

Start the Workbench from the Desktop





	The Explorer context menu

All you have to do is right click on the right folder or files in Explorer,
and select a context menu entry.



	The thg command line application

Type the appropriate commands from any command line interface, in the form
thg <command> [options].





In this quick guide we would like to make you get started using the Workbench
application, but we will also indicate how to do the same with the other
possibilities.

Mercurial commands are also available from the standard hg command
line application.


4.1. Configuring TortoiseHg

Your first step should be to make sure that you are correctly identified
to TortoiseHg.  You do this by opening the global settings dialog.

Workbench: select File ‣ Settings… from the menu

Explorer: choose TortoiseHg ‣ Global Settings from the
context menu

Command line: type thg userconfig

This opens the TortoiseHg settings dialog, editing your global
(user) configuration.


[image: Settings Dialog]

TortoiseHg Settings Dialog



First select the Commit page and enter a name in the
Username field.


Note

If you neglect to configure a username TortoiseHg will ask you to
enter one when you try to commit, which is the first time a
username is actually required.
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5. TortoiseHg in daily use
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5.1. Common Features

These features are common to many TortoiseHg tools, so we document them
here just once.


5.1.1. Visual Diffs


[image: Visual Diff Window]

Visual Diff Window



In TortoiseHg 1.0, the visual (external) diff infrastructure was
refactored.  The new system uses tool descriptions in
mergetools.rc to detect most common diff tools on your computer
(including KDiff3, which ships in our installer) and select the best
available tool.

If the user has selected a merge tool
(TortoiseHg ‣ Three-way Merge Tool), that tool will
also be used to perform visual diffs, bypassing the tool selection
process.  However the user can still select a separate tool
(TortoiseHg ‣ Visual Diff Tool) for visual diffs if
they chose.

The merge tool configuration file contains optimal command lines for
each tool, so no further configuration is required by the user.  They
only need to select the tools they wish use, or accept the defaults.

The visual diff system will use any existing extdiff configuration it
finds.  Since extdiff did not support three way diff arguments until
very recently and still does not support label arguments, you will
likely have a better experience by disabling or deleting any extdiff
configuration you may have.

The visual diff system will directly use the selected diff tool unless
the action you are attempting requires the use of the TortoiseHg visual
diff window.  The list of conditions includes:


	The selection of files being compared require multiple tools


	The selected tool forks detached background processes


	The selected tool does not support the required directory diffs


	The selected tool does not support three way comparisons


	The file changes include renames or copies




When the visual diff window is used, the temporary files are cleaned up
when the dialog is closed.  Thus it should be left open until you close
all of your diff tool instances.  When your diff tool is launched
directly, the temporary files are deleted when your tool exits.

If your diff tool is launched directly to compare a working copy file,
it will directly diff against the working file so you may modify it from
within the diff tool.  If you are comparing multiple files, the visual
diff system will make a snapshot of the working copy files and track
their initial sizes and timestamps.  When your diff tool exits, the
system compares the sizes and timestamps and copies modified files back
over the original working copies.  In this way, you can still modify
your working copy files from your visual diff tool even when performing
directory comparisons.

When the visual diff window is used to compare working copy files, it
always directly diffs against the working copy files since it always
operates on a single file at a time.


Deprecated since version 1.0: The TortoiseHg ‣ Skip Diff Window configurable
has been removed because it is now redundant.




5.1.1.1. Adding Tools

If you have a visual diff tool installed that is not supported by
TortoiseHg, you can create a tool configuration for it in your user
Mercurial.ini file.  See Mercurial’s
documentation [https://www.mercurial-scm.org/doc/hgrc.5.html#merge-tools]
on how to configure your tool for use in file merges.  When that is
complete, you can add the extra keys used by TortoiseHg for visual
diff:

diffargs:  the arguments to use for two-way file comparisons
diff3args: the arguments to use for three-way file comparisons
dirdiff:   this tool supports two-way directory comparisons
dir3diff:  this tool supports three-way directory comparisons





When building command line arguments, you can use the following
variables:

$parent1:  the file or directory from the first parent revision
$parent2:  the file or directory from the second parent revision
$child:    the file or directory from the revision being compared
$parent:   a synonym for $parent1

$plabel1:  a symbolic name for the first parent revision
$plabel2:  a symbolic name for the second parent revision
$clabel:   a symbolic name for the revision being compared





Obviously, $parent2 and $ancestor are only meaningful when used in three
way diff arguments, for viewing merge changesets.  If your diff tool
cannot use the ancestor revision in any productive way, it is safe to
leave it out of the diff3args command line.


Note

On Windows, the executable parameter can use environment variables
using the syntax ${ProgramFiles}
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5.2. Windows Explorer Integration


5.2.1. Context Menus

TortoiseHg commands may be accessed via the context menu of Explorer
windows and other applications which use the standard File/Open dialogs.
Here is the context menu for a revisioned folder:


[image: Context menu]

Context menu for a folder under Mercurial revision control



And here is the context menu for selected files or folders:


[image: Context menu]

Context menu for file or folder selection



TortoiseHg provides dialogs for the most regularly used Mercurial
commands.  Less frequently used and newly added Mercurial commands
may be accessed from the CLI (command line interface) through
cmd.exe on Windows.



5.2.2. Overlay Icons

TortoiseHg provides visual representation of the file status via overlay
icons in the MS-Explorer windows. This is similar to those that found on
other Tortoise client, such as TortoiseCVS and TortoiseSVN.

TortoiseHg shares the overlay icons with TortoiseSVN (version 1.5.x or
later) and the other “Tortoise” projects via the use of TortoiseOverlays
(another project created by TortoiseSVN team).


[image: Overlay icons]

Overlay icons in Icons view (XP)



The context menu has an Update Icons option which forces
TortoiseHg to refresh the icons in the currently browsed repository or
directory of repositories. The taskbar icon will turn green and the
directory icons will turn into question marks while this refresh is in
progress.



5.2.3. Shell Configuration

The overlay handler and context menus are configurable.  From any folder
background (even the desktop), right click and select
TortoiseHg ‣ Explorer Extension Settings. This opens the
Explorer Extension Settings dialog.

On the tab “Context Menu” you can promote individual menu options to the
top level menu.


[image: Explorer Extension Settings dialog, Context Menu tab]

Explorer Extension Settings Dialog, Context Menu tab



On the “Icons” tab you configure settings related to the overlay icons and the
icon of the “Overlay Icons Server” in the taskbar (in the notification area of
Windows).


[image: Explorer Extension Settings dialog, Icons tab]

Explorer Extension Settings Dialog, Icons tab




	Enable overlays:

	If checked, overlay icons are shown on folders and files in the
working directory (woking copy) of Mercurial repositories.
(Default: checked)



	Local disks only:

	If checked, overlay icons are only shown for volumes on local disks, not
on network shares. Scanning for Mercurial repositories over the network
may result in high latency in the user interface of explorer. Check this
option if browsing network shares becomes too slow and/or you do not need
overlay icons on non-local volumes.
(Default: not checked)



	Enabled Overlay Handlers:

	These (per user) settings provide the possibility to disable overlay
icon handlers in the shared TortoiseOverlays component.
The TortoiseOverlays component is shared by all Tortoises (TortoiseHg,
TortoiseSVN, etc), with the goal to avoid registering too many icon slots,
by using a common set of icons slots for all Tortoises (thus using the
same set of icons for all Tortoises).
The total number of overlay slots available on Windows is fairly limited and
depends on the exact Windows version. For example, on a pristine install
of Windows 7, there are only 8 free overlay handler slots available.
This section allows to disable certain non-essential overlay
handlers, to reduce icon handler slot consumption by the TortoiseOverlays
component. Unchecking handlers in this section increases the chances that
important handlers like “Normal” (green checkmark) or “Modifed” (red
exclamation mark) will still get an icon slot, even if there are too many
handlers registered on a computer.
Unchecking handlers that are not used by TortoiseHg (that is: Locked,
Readonly, Ignored, Deleted) is highly recommended, if you know that no
other Tortoises (e.g. TortoiseSVN) uses them.
Make sure the “Added” and “Unversioned” handlers are enabled, as these
are used by TortoiseHg.
(Default: all checked)






Warning

The “Enabled Overlay Handlers” settings affect all Tortoises for a user.
A logoff/login is required to make changes in that section effective.
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5.3. GNOME desktop integration

TortoiseHg also provides shell integration with the GNOME desktop via a
nautilus-python plugin.  If you have installed TortoiseHg from a
distribution package, the odds are that this extension is already
configured.  If not, please consult our Wiki for instructions on how to
enable this feature.

While the nautilus extension does not have its own GUI for managing the
overlays and context menus, it does support command promotion into the
top menu.  It requires you to edit your ~/.hgrc file and add
lines like these:

[tortoisehg]
promoteditems = commit, log, synch






[image: Nautilus screenshot]

GNOME/Nautilus screenshot



While convenient in most cases, the overlay feature can cause slowdowns on
big repositories. To disable overlays, edit your ~/.hgrc file and add:

[tortoisehg]
overlayicons = false
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5.4. Workbench

The Workbench is the primary TortoiseHg application.  It allows you
to browse your local repositories, make commits, perform searches,
synchronize with other repositories, and perform various maintenance
tasks.  Nearly every Mercurial feature is accessible from the Workbench.


[image: Workbench]

Workbench dialog.



Workbench Main Widgets are:



	Revision History View

	A tabbed widget to view multiple repositories at once. The different
columns show general information about each changeset in the graphlog.
You can configure the columns to show from the menu via
View ‣ Choose Log Columns…, and there you can reorder
the columns too. This is the main or central widget of the      Workbench
application.



	Repository Registry

	This widget, by default shown on the left, allows to manage multiple
repositories from the Workbench. You can show/hide it via
View ‣ Show Repo Registry or with the corresponding button
in the Dock Toolbar. It’s also a dockable widget.
The View ‣ Show Paths menu option allows to not only view
the names of the repositories but also their path in a second column.



	Output Log

	This dockable widget, which can be shown/hidden with
View ‣ Show Output Log, gives the user information about
the Mercurial commands that were executed during the current session.
You can also use it as a commandline by typing Mercurial commands at its
prompt  directly. It shows any error messages when appropriate. Content
is wiped when the Workbench is closed.



	Task Tabs

	The lower right part of the Workbench is occupied by a stack of widget
where you can perform various frequent tasks. It is a tabbed widget.
See further for more detail about each one.









5.4.1. Workbench Menus

The Workbench has a menu bar for accessing tool functions and for
launching other tools.



	File

	Handle repositories and settings.


[image: File menu]

File Menu





	View

	Manage the visibility of various parts of the Workbench.


[image: View menu]

View menu












	Repository

	Perform special actions on the active repository.


[image: Repository menu]

Repository menu





	Help

	About shows TortoiseHg version info.










5.4.2. Edit Toolbar


[image: Edit Toolbar]

Edit toolbar



Moving around in the revision history. All the buttons work on the current repository.



	Refresh

	Reload the revision history of the current repository.



	Back

	Go back to the previously selected revision.



	Forward

	Go forward to the next revision in your selection history or
most recent revision set query.



	Filter toolbar

	Show and activate the Filter Toolbar at the top of the revision
graph.










5.4.3. Dock Toolbar


[image: Dock Toolbar]

Dock toolbar



Show or hide some main widgets in the Workbench.



	Show Repository Registry

	Show/hide the Repository Registry widget.



	Show Output Log

	Show/hide the Output Log widget.










5.4.4. Sync Toolbar


[image: Sync Toolbar]

Sync toolbar



Synchronize your repository with other repositories.



	Incoming

	Download incoming changesets from the remote repository, store then in
a temporary bundle file, then enter bundle preview mode with the
incoming changes applied.  Incoming changesets will be shown as normal,
while others will be shown grayed in the revision graph.
The buttons Accept and Reject are then
shown at the top of the revision graph.



	Pull

	Pull incoming changesets from the remote repository, then apply
after-pull effect (update, fetch, or rebase).



	Outgoing

	Determine outgoing changesets that would be pushed to the
remote repository.  Outgoing changesets will be shown as normal, while
others will be shown grayed in the revision graph.



	Push

	Push outgoing changesets to the remote repository.










5.4.5. Task Toolbar


[image: Task Toolbar]

Task toolbar



Work with the various task tabs.



	Revision Details

	Shows information about the current revision : files added, removed,
renamed, or modified, file contents, changeset info.
See Revision Details for more detail.










	Commit

	Here you can add new files, and do your commits.
See Commit for more detail.










	Search

	For performing text searches through file content.










	Synchronize

	Gives you full control about how you let your repositories
communicate with any other repository.
See Synchronize for more detail.








There is some relation between the revision or patch selected in the graph pane,
and the task tabs.


	Clicking on the Working Directory automatically switches to the Commit task tab.


	Clicking on any revision other than the Working Directory switches to the
Revision Details task tab.




You can overrule this standard behaviour by doing an ALT-Click for making
your selection. This preserves the current task tab, no matter what revision or
patch you select.  Cursor selection movements also do not switch task tabs.



5.4.6. Filter Toolbar


[image: Filter Toolbar]

Filter features for the Workbench.



The filter bar allows one to quickly filter the changesets panel. It is based
on the Revision Sets feature of Mercurial.
See hg.1.html#revsets [https://www.mercurial-scm.org/doc/hg.1.html#revsets]
for details on how to specify revision sets.
The toolbar can be toggled with Ctrl-S. Parts from left to right:



	Clear

	Clears the search lineedit.  Essentially disables all filters.



	Filter entry

	Here you can type a filtering condition. The widget is a combobox,
holding a history of previous filtering conditions.



	Trigger

	Applies the condition set by the filter.



	Open

	Opens the RevSet dialog. There you can select and/or enter your
condition in a combined way via point-and-click and by typing.



	Delete

	Deletes the selected query.



	Toggle filter

	Applies the filter condition by sowing changesets that don’t conform
to it in a color suggesting insensitiveness, so the selected ones
stand out more.



	Branch options

	A few options for showing branches.
See Repo Settings ‣ Workbench ‣ Dead Branches for
a method to prune names from this combo box.



	Branches combo

	A combo box with the list of named branches in your repository.



	Custom Filter Combo

	Finally there is a combo box that selects among the various
filter types that can be manually specified.








If the repository tab is previewing incoming changesets, a pair of
buttons are prepended to the start of the filter bar:



	Accept

	Accept (pull) the changesets from the previewed bundle.  This
button is only visible when previewing a changeset bundle.
The after-pull effect is respected after pulling from a bundle.



	Reject

	Reject the changesets from the previewed bundle and exit preview
mode.  This button is only visible when previewing a changeset
bundle.








The Workbench will attempt to lookup the entered search phrase in the
repository to see if it matches a tag, bookmark, branch name, changeset
hash, or revision number.  If no changeset match is found, the Workbench
checks if the search phrase has any parentheses.  If no parentheses are
found, the Workbench assumes the search is a keyword and performs a
keyword() revision set search. If parentheses are found, the
Workbench assumes the search phrase is a revision set specification and
attempts to resolve the set.

If you need to perform a keyword search that includes parentheses, use
keyword("PHRASE(FOO)").



5.4.7. Revision Graph Details

The graph column shows the child-parent relationships between revisions
in your repository history.  This column auto-sizes for as many lines of
ancestry that are required to visualize the revisions you have loaded.
The column has an initial hard-limit width to prevent some degenerative
cases from breaking the viewer, but can be resized after refreshes.



5.4.8. Performance Implications

There are some Workbench features that could have performance implications in
large repositories.



	View ‣ Choose Log columns…

	Enabling the Changes column can be expensive to calculate
on repositories with large working copies, causing both refreshes and
scrolling to be slow.



	View ‣ Load all

	Normally, when the user scrolls through the history, chunks of changesets
are read as you scroll. This menu choice allows you to have the Workbench
read all the changesets from the repository, probably allowing smoother
moving through the history.










5.4.9. Revision Context Menus

Right-clicking on revisions in the graph pane brings up a different context menu
when one, two, or more revisions are selected. Context menus can also differ
according to the type of revision(s) (working dir, regular revision,
(un)applied mq patch). Here we give a list of all existing context menu entries.

Right-clicking on a selection of revisions in the (top) graph pane will bring up
the revision context menu.


	With only one revision selected:

	
[image: Single revision context menu]


	Update…

	Update your working directory to this revision. Opens the
TortoiseHg update dialog with this revision selected.



	Diff to Parent

	Open this change in your visual diff tool.



	Diff to Local

	Display changes (visual diff) between this revision and your
current working directory.



	Browse at Revision

	Brings up the Manifest window with the content of all files in the repo
at the selected revision.



	Similar Revisions…

	Open the TortoiseHg dialog to search for similar revisions.



	Merge with local…

	Merge the selected changeset with the Working Dir.  Opens the TortoiseHg
merge dialog with this revision selected.



	Tag…

	Allows to manage tags to the selected revision.



	Bookmark…

	Allows to manage bookmarks for the selected revision.



	Backout…

	Create a backout changeset for selected revision.



	Copy Hash

	Copies the revision hash to the clipboard.
Copy current revision’s full hash to the clipboard.

Under X11, the short changeset hash is automatically
copied to the primary selection when the revision is
clicked, you paste it by pressing the middle mouse
button.



	Export

	
	Export Patch…

	Generate a patch file containing this revision’s changes.



	Email Patch…

	Send this revision’s changes to email recipient.  Opens the
TortoiseHg email dialog with this revision selected.



	Archive…

	Open the archive dialog for this revision, allowing user to
generate a backup copy of the repository at that revision.



	Bundle Rev and Descendants…

	Open a dialog for exporting this revision and its descendants
to a bundle file.



	Copy Patch

	Copies this revision’s changes to the clipboard.
Only visible when MQ is enabled.







	Change Phase to

	
	public

	Change the phase of this revision to public.



	draft

	Change the phase of this revision to draft.



	secret

	Change the phase of this revision to secret.







	Graft to Local…

	Open the graft dialog to copy the selected revision.



	Modify history

	
	Unapply Patch

	Pop patches upto this one
Only visible when MQ is enabled



	Import to MQ

	Import selected revision into the current patch queue.  Only
valid for qbase or checked out head revision.  Only visible
when MQ is enabled



	Finish patch

	Transforms the MQ patch into a regular changeset.
Only visible when MQ is enabled



	Rename Patch…

	Renames the MQ patch file.
Only visible when MQ is enabled



	MQ Options

	Open the MQ options dialog.
Only visible when MQ is enabled



	Rebase…

	Move the selected revision and all of its descendants onto the
current working parent revision.
Only visible when rebase is enabled



	Prune…

	Mark the selected revision as obsolete.
Only visible when evolve is enabled



	Strip…

	Remove the selected revision and all of its descendants from the
repository [1] Only visible when MQ is enabled











	With two revisions selected:

	
	Visual diff…

	Open this change in your visual diff tool.



	Export selected

	Creates a patch file for each changeset in selected range.



	Email selected…

	Opens email dialog with range of changesets.



	Export DAG range

	Creates a patch file for each changeset in selected range.



	Email DAG range…

	Opens email dialog with range of changesets.



	Bisect - Good, Bad…

	todo
See bisect section below.



	Bisect - Bad, Good…

	todo
See bisect section below.



	Compress history…

	Brings up a dialog where you can compress the youngest changeset into
the older one.







	With more than two revisions selected:

	
	Export selected

	Creates a patch file for each changeset in selected range.



	Email selected…

	Opens email dialog with range of changesets.










[1]
The strip command will store the stripped revisions in a bundle file
that can later be reapplied.
See also EditingHistory [https://www.mercurial-scm.org/wiki/EditingHistory].




5.4.10. File Context Menus

Right-clicking on filenames in the file list pane (bottom left of the RevDetails
task tab) will bring up a context menu for the selected file:



	Visual Diff

	Open this revision of the file in your visual diff tool.



	Visual Diff to Local

	Visualize differences between this revision and your checked
out version.



	View at Revision

	Open this revision of the file in your visual editor [2].



	Edit Local

	Open the checked out version of the file in your visual editor [2].



	Revert to Revision

	Checkout this specific revision of this file [4].



	File History

	Show revisions that modified this file [3].



	Compare file revisions

	Brings up a new dialog where you can compare any revision of the file
with any other revision in the history.









[2]
(1,2)
Global Settings ‣ TortoiseHg ‣ Visual Editor



[3]
Does not show revisions where a file was deleted, as this is only a
manifest change, it does not modify the file’s history.



[4]
The new contents will appear as local changes and must be committed.


Right-clicking on filenames in the file list pane of the Commit task tab will
bring up a different context menu for the selected file:



	Edit

	Open this revision of the file in your visual diff tool.



	Add

	Add this file to the repository for versioning.



	Detect Renames…

	Brings up a dialog where you can try to detect renamed files.



	Ignore

	Adds the selected file to the .hgignore content.



	Delete unversioned

	Deletes unversioned files from disk.










5.4.11. Message Parsing

The changeset display pane will detect and underline changeset hashes,
HTTP(s) URLs, and bug report identifiers inside changeset messages.
These underlined phrases are clickable links.

Every word-boundary delimited string of 12 or 40 characters from the
range [0-9a-f] is considered a changeset link. Clicking on it in the
repository explorer will jump to the given changeset if possible.

HTTP and HTTPS URLs are similarly turned into clickable links which are
opened in your default web browser.

Issue tracker links are enabled when configured in the tortoisehg
section of your configuration files.  Since only a single issue tracker
can be configured at a time, it is typically configured in the
repository’s .hg/hgrc file.  There are two keys: issue.regex and
issue.link. The first defines the regex to match when picking up issue
numbers, while the second defines the command to run when an issue
number is recognized.

You may include groups in issue.regex, and corresponding {n} tokens in
issue.link (where n is a non-negative integer). {0} refers to the entire
string matched by issue.regex, while {1} refers to the first group and
so on. If no {n} tokens are found in issue.link, the entire matched
string is appended instead.

Examples:

BitBucket:
issue.regex = #(\d+)\b
issue.link = https://bitbucket.org/<your project and repo>/issue/{1}/

Mercurial:
issue.regex = \bissue(\d+)\b
issue.link = https://bz.mercurial-scm.org/show_bug.cgi?id={1}







5.4.12. Output Log Console

The console built into the Workbench Output Log dock widget can run
Mercurial (hg) commands, TortoiseHg (thg) commands, a couple special
commands, and limited shell commands.  Commands are always executed in
the root of the current repository.  The prompt is updated to keep you
aware of the context.

If the command line begins with ‘hg’, the Mercurial command is run in
TortoiseHg’s execution environment; meaning output is sent to the log
widget and input requests are handled by dialog windows.

If the command line begins with ‘thg’, the requested command is run in a
new window but in the same process.  For instance ‘thg ci’ will open a
new commit tool window for the current repository.

It the command is ‘clear’ (or ‘cls’), the output log contents are
erased.

If the command is ‘exit’, the output log window is closed.

Otherwise, the command line is forwarded to your platform’s default
command shell with a limited execution context.  There is no stdin while
stdout and stderr are piped to the output log.



5.4.13. Keyboard navigation


	Ctrl-P

	Zoom to the working directory parent revision



	Ctrl-D

	Display visual diffs for selected changeset or file



	Ctrl-S

	Toggle revision set / filter toolbar





See also KeySequences [https://bitbucket.org/tortoisehg/thg/wiki/KeySequences]
on the wiki pages.



5.4.14. Configurables

The Workbench has a few configurable options that can be set in
the TortoiseHg Settings dialog on the Workbench tab.



	Author coloring

	If true, each author’s changeset will be given a unique color



	Long Summary

	Concatenate commit message lines until 80 chars are reached



	Graph batch limit

	Number of revisions to read in each batch load



	Dead Branches

	Comma separated list of branch names that should be ignored
when building a list of branch names for a repository.



	Branch Colors

	Space separated list of branch names and colors on the
form branch:#XXXXXX. Spaces and colons in the branch name must be
escaped using a backslash (\). Likewise some other characters
can be escaped in this way, e.g. \u0040 will be decoded to the
@ character, and \n to a linefeed.



	Hide Tags

	Space separated list of tags that will not be shown.  Useful
example: Specify “qbase qparent qtip” to hide the standard tags
inserted by the Mercurial Queues Extension.








The exact colors given to particular users can be configured by adding
lines like these to your Mercurial.ini file:

[tortoisehg]
authorcolor.USERNAME = color





The Workbench also respects the following settings on the
TortoiseHg tab:



	Tab Width

	Number of spaces to expand tabs in diffs



	Max Diff Size

	Maximum size of file to be diffed










5.4.15. From command line

The Workbench can be started from command line

thg log [OPTIONS] [FILE]

aliases: history, explorer, workbench

workbench application

use "thg -v help log" to show global options
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5.5. Create a new repository

To create a new repository into an existing directory (project) you
have to run the init dialog. From the explorer context menu select
TortoiseHg… ‣ Create Repository Here over the directory, or, within
the folder, type thg init.


[image: Init dialog]

Repository Init Dialog




	Destination

	Is the directory where the repository will be created. It is
always filled with the current directory, so if you launch the
dialog from the right directory there is no reason to change it.



	Create special files (.hgignore, …)

	If selected TortoiseHg creates an empty .hgignore file
in the working directory.



	Make repo compatible with Mercurial <1.7

	If selected TortoiseHg creates an older format Mercurial repository.
Do not check unless you have a strong reason to do, and you know
what you are doing.



	Show in Workbench after init

	When the repository was successfully created, it is added to the RepoRegistry,
and opened in a new tab the Workbench.



	Hg command

	This field displays the command that will be executed by the dialog.





Creating a new repository means create a subdirectory called .hg.
In this subdirectory Mercurial keeps all its versioning information.


Warning

It is dangerous to manually edit the files in .hg directory,
repository corruption can occur.  .hg/hgrc is perhaps the
only exception to this rule.
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5.6. Clone a repository

To clone a repository you have to run the clone dialog.
From the explorer context menu select TortoiseHg… ‣ Clone a repository
or type thg clone.


[image: Clone dialog]

Clone Dialog




	Source

	It is the path (or URL) of the repository that will be cloned. Use
the Browse… to choose a local folder.



	Destination

	It is the path of destination directory, a folder with the same name
of source repository will be created within this directory.





Under the Options expander you will find:


	Clone To Revision

	You can limit the clone up to this revision. Even the tags created
after this revision will not be imported.



	Do not update the new working directory

	If checked, after the clone the working directory will be empty. It
is useful when you have to clone a repository with the purpose of
central repository, or backup, where you have only, in the future,
to push and pull.



	Use pull protocol to copy metadata

	When the source and destination are on the same filesystem,
Mercurial tries to use hardlinks. Some filesystems, such as AFS
implement hardlink incorrectly, but do not report errors. Use this
option to avoid hardlinks.



	Use uncompressed transfer

	To use uncompressed transfer (fast over LAN).



	Include patch queue

	To also clone an MQ patch repository along with the main repository.
It is possible to provide a patch queue name that differs from the
default one.



	Use proxy server

	To use the proxy server configured in TortoiseHg… ‣ Global Settings ‣ Proxy.
This is enabled only if a proxy is configured.



	Do not verify host certificate

	Skip checking server certificate for https:// url (ignoring web.cacerts config).



	Remote command

	Specify a Mercurial command to run on the remote side.



	Hg command

	This field displays the command that will be executed by the dialog.






5.6.1. From command line

The clone tool can be started from command line

thg clone





The syntax is

thg clone [SOURCE] [DEST]





where [SOURCE] and [DEST] are, the paths of source repository and destination folder.
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5.7. Commit

The commit tool is second most commonly used application after the
Workbench.  Not only can the commit tool commit your changes, but it can
also examine the state of your working directory and perform most
routine maintenance tasks (add new files, detect renames, manage the
ignore filter, etc).


[image: Commit dialog]

Commit dialog




5.7.1. Features

Enumerating the toolbar buttons:



	Branch dialog

	Shows the current branch name of the working directory. Normally
this is informational only, but pressing this button opens up a
branch maintenance dialog.  Do not use this feature unless you
understand Mercurial’s
named branches [https://www.mercurial-scm.org/wiki/NamedBranches].



	Recent Commit Messages

	A drop-down list of the 10 most recent commit messages. The
the drop-down list is filled the first time it is opened.



	Commit

	Commit selected diffs in checked files.



	Undo

	Undo (rollback) last immediate commit. Your commit message will be
available in the message history, so you can easily repeat the
commit if necessary.








The file list has four columns:



	A checkbox that indicates whether the file is selected for an
operation.  The toolbar buttons only operate on checked files.
“Partially” selected files have a special check state.  This
column header is checkable, it will toggle the file selection
states.


	The st column holds the status of the file, defined
by Mercurial’s status command, one of ‘MARD?IC’.  A status of ‘S’
indicates a dirty subrepository that needs to be committed.


	The ms column holds the merge state of the file,
defined by Mercurial’s resolve command, one of ‘ RU’.  See the
merge section below.


	The canonical path of the file relative to the repository root








Note

If the commit tool was started with a file pattern or selection, a
button will appear at the bottom of the file list that can clear the
file pattern and give you an unfiltered view of the entire working
directory.
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5.8. Shelve

The shelve tool can move changes between the working directory and shelf
patches.   If the MQ extension has been enabled, it can also move
changes into and out of unapplied patches.

The shelve tool can be launched by the Workbench Repository –>
Shelve menu option, by a toolbar button on working file viewers, or
by thg shelve.


Note

We highly recommend setting the patch eol configuration to auto if
you use the shelve tool with DOS eoln text files.
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5.9. Synchronize


[image: Synchronize dialog]

Synchronize dialog



The synchronize tool is used to transmit changesets between repositories
or to email recipients.



	Incoming

	show changesets that would be pulled from target repository, the
changes in the target repository that are not in local repository



	Pull

	pull incoming changesets from target repository



	Outgoing

	show changesets that would be pushed to target repository, the
changes in the local repository that are not in target
repository



	Push

	push outgoing changesets to target repository, make the local
tip the new tip in the target repository



	Email

	send outgoing changesets (to target repository) as email



	Stop

	stop current operation








The Post Pull dialog contains radio buttons for selecting
the operation which is performed after a pull.  If you open the
configuration tool, you can select a default behavior for your user
account and override that selection on a per-repository basis.



	None

	No operations are performed after a pull.  You will be allowed to
view the pulled changesets in the log viewer, and you will have the
option to update to the new tip if applicable.



	Update

	Automatically update to the current branch tip if, and only if, new
revisions were pulled into the local repository.  This could trigger
a merge if the pulled changes conflict with local uncommitted
changes.



	Fetch

	Equivalent to hg fetch.  See the fetch extension documentation for
its behavior.  This feature is only available if the fetch
extension has been enabled by the user.



	Rebase

	Equivalent to pull –rebase.  See the rebase extension
documentation for its behavior.  This feature is only available
if the rebase extension has been enabled by the user.



	Automatically resolve merge conflicts where possible

	If update or rebase are selected, a pull operation may result in
a merge.  If checked, Mercurial will try to resolve trivial
merge conflicts without user interaction.  If not checked, all
merges will be interactive.








The Options dialog provides checkboxes for selecting
infrequently used command options.



	Allow push of a new branch

	allow a new named branch to be pushed



	Force pull or push

	override warnings about multiple heads or unrelated repositories



	Recurse into subdirectories

	incoming or outgoing commands can recurse into subdirectories
and provide a full report



	Temporarily disable configured proxy

	only sensitive when a web proxy is configured for the given
repository.  While checked it will disable that proxy.



	Remote Command

	provides a –remotecmd argument








When the sync tool is opened within the Workbench, the toolbar has a
Target checkbox.  While checked, the target dropdown box is
sensitive and the selected target revision, bookmark, or branch will be
added to every synchronization command.  When the sync tool is opened
outside of the Workbench, the target checkbox and dropdown box is
hidden.  Clicking on a revision in the graph will update the values in
the dropdown box.  Holding Alt while clicking on a revision will
select the revision without switching away from the sync tool tab.

Below the toolbar is the currently selected URL.  All synchronization
commands will use this URL.  The general effect of the toolbar is that
it can be read as a Mercurial command line.  The tool buttons select the
command, the Post Pull and Options dialog
specify options, the target dropdown box can specify revisions, and
finally the URL completes the command.


5.9.1. Adding an URL

By far the easiest way to add a new URL to your respository is to drag
and drop the URL from another application, then press the save button
and provide the URL an alias.

The two list panes display URLs that are stored in the current
repository’s configuration file (Stored Paths) and URLs that are
stored in other related repositories that are listed in the Workbench
repository registry (Related Paths).  When the sync tool is opened
outside of the Workbench, the Related Paths list will be empty.


Note

Being related means two repositories share at least a common root
changeset.  Cloned are obviously related.  Push and pull operations
require that repositories to be related, or that you use –force to
override the relationship check.
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5.10. Serve

Mercurial comes with an in-built, light-weight web server capable of serving
a single repository for single connection. Serve does not provide user
authentication, but does provide a convenient, ad-hoc method of synchronizing
a repository over a local network. For more complete information on publishing
repositories, see the Mercurial wiki article on
Publishing Repositories [https://www.mercurial-scm.org/wiki/PublishingRepositories].


5.10.1. From TortoiseHg


[image: Web server dialog]

The serve tool is a wrapper for Mercurial’s built-in web server. Once
launched, a computer can connect to the http port and browse your
repositories, perform clone, pull, or even push operations if enabled.
The web server can be launched from either the Workbench
(Repository Menu) or the
Context Menu.

Toolbar buttons:



	Start

	start the web server



	Stop

	stop the web server



	Configure

	Configure repository web style, description, and access policies








When the settings dialog is launched via the Configure
button, it is run in the context of the current repository.  Please
visit the Mercurial wiki for detailed descriptions of the various
web configurations.

In TortoiseHg 2.0, the serve tool natively supports collections of local
repositories.  Just drag them onto the web serve dialog while it is not
running, or add them by hand using the editing buttons.  The repository
collections can be saved and reloaded.



5.10.2. From command line

The server tool can be started from command line

thg serve [OPTION]...

start stand-alone webserver

options:

        --webdir-conf  name of the webdir config file

use "thg -v help serve" to show global options
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5.11. Detect Renames


[image: Rename guessing dialog]

Rename Guessing Dialog



This dialog is used to find renames, moves, and/or copies that were done
without Mercurial’s knowledge.  The dialog can be launched from the
shell context menu, or from the status or commit tools via the context
menu of an unknown file.

Follow these steps:


	select one or more of the Unrevisioned Files


	slide the Min Similarity bar to the percentage match you desire


	uncheck Only consider deleted files to search for copies


	press Find Rename


	preview Candidate Matches and accept good matches


	repeat until all unrevisioned files are matched





5.11.1. Candidate Matches

When you select a match in this list, the differences between the two
files are shown in the bottom pane.  Pressing Accept Match
will record the rename or copy event with Mercurial.



5.11.2. From command line

The guess tool can be started from command line:

thg guess

guess previous renames or copies

use "thg -v help guess" to show global options
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5.12. Ignore Filter

The ignore dialog is used to maintain your Mercurial repository’s ignore
filter, which can be found in an .hgignore file in the
repository root.  The dialog can be launched from the shell context
menu, or from the status or commit tools via the context menu of an
unknown file.  The Glob combo allows to switch between glob
or regexp patterns.


[image: Ignore filter dialog]

Ignore Filter Dialog




5.12.1. From command line

The ignore tool can be started from command line:

thg hgignore [FILE]

aliases: ignore, filter

ignore filter editor

use "thg -v help hgignore" to show global options









          

      

      

    

  

  
    

    5.13. Archiving
    

    
 
  

    
      
          
            
  
5.13. Archiving

You can choose from quite a lot of formats to make an archive of a repository.
There are the usual compressed formats, of course, but it’s also possible to make a
folder of the uncompressed files in a place other than the Working Directory (like a clone,
but without the .hg folder). Such archives, for example, can be useful for doing builds (similar
to ‘svn export’). Archives may also be useful for sending changes to external people
without access to the reposity, where only the effected files of a given revision or set
of revisions need be included in the archive.


5.13.1. From TortoiseHg

From the changelog context menu in the Workbench select
Export ‣ Archive… for the choosen changeset.


[image: Archive dialog]

Repository Archive Dialog




	Revision

	To select the revision you wish to archive or export.



	Only files modified/created in this revision

	To limit the number of files in the archive.



	Destination path

	The filename or directory where the archive will be created. The archive is filled
with the name of the current repository, suffixed with the revision number
of the selected revision, and has the appropriate extension of the selected
archive type.



	Archive types

	Here you can choose the type of archive to create, ranging from a plain
folder with files to a variety of standard archive type.



	Hg command

	This field displays the command that will be executed by the dialog.



	Always show output

	To have an logging output pane with the results of the command while it runs.





Archiving a repository means create an archive file or subdirectory with the
contents of the selected revision.



5.13.2. From command line

The archive tool can be started from command line

thg archive





The syntax is

thg archive -r [REV] -t [TYPE] [DEST]





where [REV] is the revision to archive, [TYPE] is the type of archive to create,
and [DEST] is the name of the file or folder to create.

See hg.1.html#archive [https://www.mercurial-scm.org/doc/hg.1.html#archive]
for details, or type hg help archive at the command line or in the
Output Log of the Workbench.
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6. Settings
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Settings dialog



The Settings dialog is used to configure both TortoiseHg and the
underlying Mercurial DVCS.  Since TortoiseHg uses Mercurial’s underlying
configuration system to store and retrieve its settings, these are
essentially the same thing.

Mercurial on Windows has a three-tier configuration system.


	A site-wide configuration file in
C:\Program Files\TortoiseHg\Mercurial.ini
This file is read first and thus has the lowest priority.


	A per-user configuration file in
C:\Documents and Settings\username\Mercurial.ini
This file is read second and thus can override settings in the
site-wide configuration file.


	A per-repository configuration file in repo-root\.hg\hgrc This
file is read last and can override site-wide and user global settings.




The site-wide file can be overwritten on upgrades so it is recommended
that you do not make changes to this file.  Instead, you should make
changes to your user Mercurial.ini and/or the repository
hgrc file.  The TortoiseHg Settings dialog enforces this
suggestion by only operating in two modes:


	Global

	edits your user Mercurial.ini file



	Repository

	edits a repository .hg/hgrc file





You may toggle between the two modes using the combo box at the top of
the dialog, or directly edit the file in your configured visual editor.

Most TortoiseHg users will want to store all configurables in their
global user settings, and only use the repository hgrc to store paths
(remote repository aliases) and web settings, though it is possible to
override many configurables per-repository (a common example is to
configure a username for use in a specific repository).  Also note that
the user and repository configuration files may not exist until you run
the Settings dialog for the first time.


6.1. Tabs

The Settings tool is a tabbed application.

Each tab corresponds roughly to a section of your Mercurial.ini
file, though there is a certain amount of overlap. Some sections were
split across multiple tabs for clarity.

Every tab but Sync has the same format, a list of
configurable options with a drop-down combo box with possible values and
a history of options you have used for that setting. The configurable
name (label) has a tooltip which describes in more detail what you are
configuring and its default value.  The description of the currently
focused configurable is also shown in a text box at the bottom of the
dialog.

Please consult the Mercurial wiki for more detailed information about
these configurables (except for the first three tabs:
TortoiseHg, Commit, Changelog, which
are specific to TortoiseHg).


6.1.1. TortoiseHg


	UI Language:

	Specify your preferred user interface language (restart needed)



	3-way Merge Tool:

	Graphical merge program for resolving merge conflicts.  If left
unspecified, Mercurial will use the first applicable tool it finds
on your system or use its internal merge tool that leaves conflict
markers in place.  Chose internal:merge to force
conflict markers, internal:prompt to always select local
or other, or internal:dump to leave files in the working
directory for manual merging.



	Visual Diff Tool:

	Specify visual diff tool as described in the [merge-tools] section
of your Mercurial configuration files.  If left unspecified,
TortoiseHg will use the selected merge tool. Failing that it uses
the first applicable tool it finds.



	Visual Editor:

	Specify visual editor, as described in the [editor-tools] section
of your Mercurial configuration files.  If left unspecified, TortoiseHg
will use the first applicable tool it finds.



	CLI Editor:

	The editor used by Mercurial command line commands to collect
multiline input from the user.  Most notably, commit messages.



	Shell:

	Specify the command to launch your preferred terminal shell
application. If the value includes the string %(reponame)s, the
name of the repository will be substituted in place of
%(reponame)s. Similarly, %(root)s will be the full path to
the repository. (restart needed)


	Default, Windows:

	cmd.exe /K title %(reponame)s



	Default, OS X:

	not set



	Default, other:

	xterm -T "%(reponame)s"







	Immediate Operations:

	Space separated list of shell operations you would like to be
performed immediately, without user interaction. Commands are “add
remove revert forget”. Default: None (leave blank)



	Tab Width:

	Specify the number of spaces that tabs expand to in various
TortoiseHg windows. Default: 8



	Force Repo Tab:

	Always show repo tabs, even for a single repo. Default: False



	Monitor Repo Changes:

	Specify the target filesystem where TortoiseHg monitors changes.
Default: localonly



	Max Diff Size:

	The maximum size file (in KB) that TortoiseHg will
show changes for in the changelog, status, and commit windows.
A value of zero implies no limit.  Default: 1024 (1MB).



	Fork GUI:

	When running thg from the command line, fork a background process
to run graphical dialogs. Default: True.



	Full Path Title:

	Show a full directory path of the repository in the dialog title
instead of just the root directory name.  Default: False



	Auto-resolve merges:

	Indicates whether TortoiseHg should attempt to automatically resolve
changes from both sides to the same file, and only report merge
conflicts when this is not possible. When False, all files with
changes on both sides of the merge will report as conflicting, even
if the edits are to different parts of the file. In either case, when
conflicts occur, the user will be invited to review and resolve
changes manually. Default: True.



	New Repo Skeleton:

	If specified, files in the directory, e.g. .hgignore, are copied
to the newly-created repository.







6.1.2. Workbench


	Single Workbench Window:

	Select whether you want to have a single workbench window. If you
disable this setting you will get a new workbench window everytime
that you use the “Hg Workbench” command on the explorer context menu.
Default: True



	Default widget:

	Select the initial widget that will be shown when opening a
repository. Default: revdetails



	Initial revision:

	Select the initial revision that will be selected when opening a
repository.  You can select the “current” (i.e. the working directory
parent), the current “tip” or the working directory (“workingdir”).
Default: current



	Open new tabs next to the current tab:

	Should new tabs be open next to the current tab? If False new tabs
will be open after the last tab. Default: True



	Author Coloring:

	Color changesets by author name. Default: False



	Full Authorname:

	Show full authorname in Logview. If not enabled, only a short part,
usually name without email is shown. Default: False



	Task Tabs:

	Show tabs along the side of the bottom half of each repo widget
allowing one to switch task tabs without using the toolbar. Default:
off



	Task Toolbar Order:

	Specify which task buttons you want to show on the task toolbar and
in which order.
Type a list of the task button names. Add separators by putting “|”
between task button names.
Valid names are: log commit sync grep.
Default: log commit grep | sync



	Long Summary:

	If true, concatenate multiple lines of changeset summary and truncate
them at 80 characters as necessary. Default: False



	Log Batch Size:

	The number of revisions to read and display in the changelog viewer
in a single batch. Default: 500



	Dead Branches:

	Comma separated list of branch names that should be ignored when
building a list of branch names for a repository. Default: None
(leave blank)



	Branch Colors:

	Space separated list of branch names and colors of the form
branch:#XXXXXX. Spaces and colons in the branch name must be
escaped using a backslash (\). Likewise some other characters can
be escaped in this way, e.g. \u0040 will be decoded to the @
haracter, and \n to a linefeed. Default: None (leave blank)



	Hide Tags:

	Space separated list of tags that will not be shown. Useful example:
Specify “qbase qparent qtip” to hide the standard tags inserted by
the Mercurial Queues Extension. Default: None (leave blank)



	Activate Bookmarks:

	Select when TortoiseHg will show a prompt to activate a bookmark when
updating to a revision that has one or more
bookmarks.


	auto :

	Try to automatically activate bookmarks. When updating to a revision
that has a single bookmark it will be activated automatically. Show
a prompt if there is more than one bookmark on the revision that is
being updated to.



	prompt :

	
	The default. Show a prompt when updating to a revision that has one

	or more bookmarks.







	never :

	Never show any prompt to activate any bookmarks.





Default: prompt



	Show Family Line:

	Show indirect revision dependency on the revision graph when filtered
by revset. Default: True


Note

Calculating family line may be slow in some cases. This option is
expected to be removed if the performance issue is solved.
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7. Patches


7.1. Defining a patch

These links are recommended reading for understanding the history and nature
of patches and how they can be used with Mercurial.


	The patch management problem [https://tortoisehg.bitbucket.io/hgbook/1.7/managing-change-with-mercurial-queues.html#sec:mq:patch-mgmt]


	Understanding patches [https://tortoisehg.bitbucket.io/hgbook/1.7/managing-change-with-mercurial-queues.html#sec:mq:patch]


	More about patches [https://tortoisehg.bitbucket.io/hgbook/1.7/managing-change-with-mercurial-queues.html#sec:mq:adv-patch]






7.2. Pitfalls

The standard patch format cannot describe binary files, renames, copies,
or permission changes.  If your patch needs to record any of those
things, you will need to enable git patches via:

[diff]
git=True





Mercurial 1.5 improves its behavior in this regard.  It will warn you
when git diffs are required, or sometimes upgrade to the git format
automatically.  See also the
diff section [https://www.mercurial-scm.org/doc/hgrc.5.html#diff] of
the hgrc documentation.

Mercurial’s patch routines do not deal well with mixed EOLN between
source files and patches.  The patch.eol setting was introduced in
1.3 to improve this situation:

[patch]
eol = auto #strict, lf, or crlf






Note

When eol is set to auto, the patching engine will preserve the line
endings of the patched file regardless of the line endings in the
patch itself.  You almost always want eol to be configured to auto.
The only downside is that you cannot make a patch that changes the
line endings of a source file.
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8. Extensions

This chapter describes Mercurial extensions that are shipped with
TortoiseHg binary packages for Windows.  These external extensions are
included as a convenience to users, so they can be easily enabled as
soon as they are needed.


8.1. Hgfold

hgfold [https://www.mercurial-scm.org/wiki/CaseFoldExtension] is a
Mercurial extension that helps Windows users deal with